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FUSION - What is FUSION?

» It’s the Facility Utilization, Space Inventory
Options Net

- The internet based software program developed for
the California Community College system with
funds from 11 districts

- Allows the Chancellor’s Office to easily access our
facility needs on a statewide basis and attach a
dollar value to our scheduled maintenance and
capital outlay requests




FUSION - How many parts are
there?

» There are 5 parts to FUSION
- Assessment is for viewing facility deficiencies
and other facility conditions.
- Space Inventory is for adjusting space inventory
data.
- Planning is for creating and editing five year
nlans, enrollment forecasts and SMSR plans.
- Project is for accessing data for each on-going
State funded project.
- Emanual is a procedural manual and help
system for this application.




FUSION - What does each Module
provide?

» Assessment Module
- |t provides detailed Facility Condition Index (FCI) for
each building
- Calculates replacement value and repair costs
- Updated every 3-4 years by FUSION team




FUSION - What does each Module
provide?

» Space Inventory Module
- Total # of Sites
> Total # of Buildings
- Total # of Rooms

- Includes breakdown between lecture rooms, labs,
offices, library space, AV/TV and Other spaces

- Total # of Assigned Stations
- Age of building and year built

> Includes gross square footage (OGSF) and
assignable square footage (ASF)

- # of Acres for each site
Updated annually by Mid October
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FUSION - What does each Module
provide?

» Planning Module - Capital Outlay

> 5-Year Capital Outlay Plan
- Includes Initial Project Proposals (IPPs)
- Shows status as Approved or Submitted
* Includes Final Project Proposals (FPPs)
- Shows status as Approved or Submitted

- Drill down to JCAF 32 - summary of project cost and
breakdown of State vs. District supported

- Includes Locally funded projects
- Listed in priority order
- Updated annually by July 1st




FUSION - What does each Module
provide?

» Planning Module - Local Assistance

> 5-Year Scheduled Maintenance Plan

- Projects segregated into one of 5 categories:
- Roofs
- Utility
- Mechanical
- Exterior
+ Other
- Projects limited to a total cost of $634,000 per project

- Updated annually by December 1st




FUSION - What does each Module
provide?

» Project Module

> Lists the active State funded Capital Planning
Projects and an archive of changes

- Lists Department of Finance actions and dates
> Claims Review
> Quarterly Reporting

- Must be submitted each quarter until project is
completely closed out

- Submit report even if no expenditures in quarter




FUSION - How do | access it?

» Go to:
o http://fusion.deltacollege.edu/code/admin/default.

htm
» You get a login and password from the
person at your District with administrative
rights
» It can only be opened using Internet Explorer
- All other web browsers won’t work (for now)



http://fusion.deltacollege.edu/code/admin/default.htm

FUSION - How do | navigate Home

Page?

<« - B

& California State Commu

ssion deltacolleg

FUSION Today

Tuesday, Apr 12, 2016 7:00:04 PM

Welcome to FUSION.
There are 5 medules in FUSION.

1) is for viewing facilfty and other facilty data.
2) Space Inventory is for adjusting space inventory data.

3) Planning s for crealing and edifing five year plans and forecasts

4) Project is for accessing data for each on-going project.

5) Emanual is a procedural manual and help system for this application

Tuesday, September 15 2015: September 15 2015 was the deadiine for district's fo submit their 201516 Local Assistance
Project Funding Proposals (PFPs). The memarandum outlining this submittal is posted in the documents section of FUSION
Forum-Local Assistance.

Friday. Oclober 16, 2015: October 16 2015 was the submitial deadline for District 2015-16 Space Inventory. See the Space
Inventory folder in the documents section of FUSION Forum for infermation about this submittal

Friday. July 01, 2016: July 1 is the deadline for districts to submit their Capital Outlay Proposals and 5-Year Construction
Plans. Please see the Capital Outlay folder in the documents section of FUSION Forum (FP15-09) for information about this
submittal

Monday February 29, 2016: Updated enrollment projections are in FUSION - February 23 2016 is the deadiine for districts
to appeal for their Long-Range Enrollment and WSCH projections. See the Capital Outlay folder in the documents section of
FUSION Forum (FP 16-06) for information

Tuesday, December 01, 2015: December 1 2015 was the deadline for district's to submit their 2016-17 Scheduled
Maintenance & Special Repairs -5-Year Plan in FUSION

Wednesday, February 08, 2012: Information about the 2012 BOG Energy and Sustainability Award program has been
posted 1o the energy folder in the documents section of FUSION Forum (See Links section to the right).

Thursday. September 20. 2012: New CO Project Closout Procedures have been defined. Please see the documents
section of FUSION Forum (Gapital Outlay folder) for an email from Fred Harris outlining the update.

Tuesday, June 04, 2013 District CBOs may now electronically sign and submit ceriifications for Space Inventory Reporis
and Five Vear Capital Outlay Plans - see Downloads (this page) or Documents (Capital Outlay) in FUSION Forum for
information and related forms.

Friday, September 05. 2014: A new with supporting regarding 2014-15 Physical Plant and
Instructional Support Certification and Allocations has been posted fo the decuments section (Local Assistance foider) of
FUSION Forum

Friday, January 29, 2016; The next beginning FUSION class is scheduled for Friday January 28 at ML San Antonio
Gollege. Please contact Walt Kems (wkerns@foundationcee org) if you are interested

View/Edit Cost Guidelines

View Constructicn Unit Costs

View User Security Roles

FUSION {Facility Utilization. Space Inventory
rework developed for
the CCC system.

FUSION is a web-based suits of tools used by all
California community colleges fo support the
integrated management and raporting on
facilities throughout the state
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& Home | Assessment | Spacelnventory | Planming | Project | @ Emanual

2088 2017-18, SI 14-15|

FUSION Forum
€CC Chancellor's Office Directory

€CC Chancelor's Office Faciliies Reference Material

CCC Chancelior's Office Facilties Planning Memorandums

CCC Geographic Information Systems

Architectural Drawings DB

FUSION Farum Documents Section

Furniture Bulk Purchase Opportunities

New FPP Format - Recorded Presentation by FPU Staff at LECC
New JCAF 32 and QSUC Webinar - Recorded 2125/16

« Need help with FUSION? Please email fusionhelp@foundationcee. org or phone either 1-866-325-3222( 5

916-325-1863/") or 209-954-5362( 5

Ezms Energy Usage Galculator 201213 data final.xis 9172013

[l capital Qutlay FUSION Claim Cerlification Form (2).pdf

ange Plannin

6102013
[Tl istrict Assignments Dec 15 pdf 132016
(i} :;‘:;.rns CBO Electronic Signature Submittal for Space Inv 5YP 6 2 6102013
Ll Fusion Elec Signature Reports Instructions § 2 13,pef 6102013
[CFusion Expenditure Recap Formads 9/26/2008
[Crusion Tmeline par V112011
[ClFUSION Claims Processing Overview pdf 122202010
ClHow to assign new FUSION users.exe 472202004
Dy Fusion Screen is too small.exe 11132004
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FUSION - How do | navigate

Assessment?

LI & hetp://fusion

du/code/admin/

& California State Commu

: 2.0 Deficiencies

B california Community Colleges
[ Long Beach
B Liberal Arts Campus

ART K (3)

AUDITORIUM J (2)

BOOKSTORE I (55)

BUS-50C SCI-FOR LANG M (4)
CENTRAL PLANT X (1)

CHILD DEVELOPMENT CTR 1 (37]
CHILD DEVELOPMENT CTR 3 (35]
COLLEGE CENTER E (28)
COMMUNITY OUTREACH 1 {62)
COMMUNITY OUTREACH 2 (63)
FAMILY CONS STUDIES F (10)
GROUNDS SHOP U (44)
GYMNASIUM MEN R (7)
GYMNASIUM WOMEN Q (8)
LANGUAGE ARTS P (6)
LIBRARY LEARNING CTR L (3)
MAIL ROOM MR (57)

MAINT. & OPS COMPLEX Z (59)
MAINTENANCE SHOP Y (54)
MATH/TECHNOLOGY V (64)
MUSIC G (12)

NURSING HEALTH-TECH C (33}
PARKING STRUCTURE (PS) (65)
PHYSICAL EDUCATION OFF (51)
RR (67)

SCIENCE BUILDING D (39)
SOUTH QUAD T (58)

STADIUM PRESS BOX (60)
STUDENT CENTER A (1)
TECHNICAL B (38)

TENNIS STORAGE (66)
THEATER ARTS BLDG H (48)
VETERANS' STADIUM S (50)
Pacific Coast Campus

ASSESTMENT » Facility >
0011 ADMIN SERVICES N

General Info:
Type:

Gross Area

Year Built

Last Renovation.

Fadility Description:

0011.

: Building

: 12292 5. F.
: 1935

: 1975

FCI%:  46.19%

FCI Details »

& Home

Assessment

Space Inventory

AEd hx @

Planning | Project

@ Help Me!

Administrative Services is located on the Liberal Arts Campus of Long Beach City College in Long Beach, California. The 1-story, 12,292 square foat building contains offices. Originally constructed in 1935, with a renovations in 1975, electrical, plumbing fixtures, mechanical, and fire alarm systems. There has been no

major remodels to date, 2015. A major remodel consists of a full gut with face to stud replacement.

ICTURAL/EXTERIOR CLOSURE:

The building typically rests on ... Read More.
Life Cycle:
Cost Model: CC Admin 15nCP CF

System Cost/S.F. Life Used Priority Safety Adjust Amount
A1030 Slab on Grade $34.34 100 100% 7% 1 1 $0.00
B1020 Roof Construction $24.64 100 120% A% i 1 $0.00
B1010 Floor Construction $4.33 100 100% %% 1 1 $0.00
B2010 Exterior Walls $35.34 100 100% 9% 1 1 $0.00
B2020 Exterior Windows §8.49 35 105% 100% 1 1 $0.00
B2030 Exterior Doors $1.32 30 105% 100% 1 1 $0.00
B3010 Roof Coverings $31.84 20 120% 100% i 1 $0.00
C1010 Partitions $10.96 30 110% 100% 1 1 $0.00
€1020 Interior Doars $18.40 30 110% 100% i 1 $0.00
£3020 Floor Finishes $25.19 20 105% 100% 1 1 $0.00
(C3030 Ceiling Finishes $22.11 25 105% 100% 1 1 $0.00
€3010 Wall Finishes $9.76 15 100% 100% 1 1 $0.00
D2010 Plumbing Fixtures $19.05 30 100% 100% 1 1 $0.00
D3030 Cooling Generating Systems $95.52 30 100% 50% i 1 $0.00
D3020 Heat Generating Systems $52.63 35 100% 7% 1 1 $0.00
D4030 Fire Protection Specialties $9.55 35 100% 100% i 1 $0.00
D5010 Electrical i $47.28 35 100% 100% 1 1 $0.00
D5030 Ce and Security §1.23 0 100% 80% 1 1 $0.00
F1030 Special Construction Systems §2.17 25 110% 6% 1 1 $0.00
Total $464.16

2 B

2 Emanual

711 PM
412/2016




FUSION - How do | navigate Space
Inventory?

LI & hetp://fusion du/code/adrmin/ [ AE] " X It @

& California State Commu

& Home | Assessment | Space Inventr Planning | Project | % Emanual

ange Planning Year: IV CAD SURE]

=} Color Code Long Beach Community College District - 2014/2015
5] ono Beac District Profile %
B Liberal Arts Campus District Code: 840 Number of Approved Sites: 2
[J ADMIN SERVICES N (11) District Name: Long Beach Gemmunity College District Total Buildings 53
Chief Executive Officer Eloy Ol Total Rooms: 1,609
[ ART K (3)
[ AunITORIUM J (2) Trtie: Superintendent/President Total Assign Stations: 15,099
BOOKSTORE (55) Contact Person Name Medhanic Ephrem Total Assignable Sq Ft: 779,509
BUS-S0C SCI-FOR LANG M (4) Phone Number (562) 938-5008 Total Outside Gross Sq Ft 1,221,817
CENTRAL PLANT (61) District Address: 4901 East Carson Street
CHILD DEVELOPMENT CTR 1 (37 ooy Eersh e €545
CHILD DEVELOPMENT CTR 2 (34 PO Land/Locations | Bidg. Reconcil | Comments | Reports
CHILD DEVELOPMENT CTR 3 (35
COLLEGE CENTER E (28) Aesianable p—
COMMUNITY OUTREACH 1 (62) Campus Code Campus Name Campus Type Campus Size Asstanable fosianed
COMMUNITY QUTREACH 2 (63
(63) 841 Liberal Arts Campus Campus with L 597,552 923,312 11,296

FAMILY CONS STUDIES F (10) District Office
GROUNDS SHOP U (44) 842 Pacific Coast Campus Campus s 181,857 298,305 3203
GYMNASIUM MEN R (7}
GYMNASIUM WOMEN Q (8)
LANGUAGE ARTS P (6)
LIBRARY LEARNING CTR L (9)
MAIL ROOM MR, (57)
MAINT. & OPERATIONS COMPLE;
MAINTENANCE SHOP Y (54)
MUSIC G (12)
NURSING HEALTH-TECH C (33)
PHYSICAL EDUCATION OFF (51)
SCIENCE BUILDING D (39)
SOUTH QUAD T (58)
STADIUM PRESS BOX (60)
STUDENT CENTER A (1)

[0 TECHNICAL B (38)

L[] THEATER ARTS BLDG H (48)

L[] VETERANS' STADIUM § (50)
[ Pacific Coast Campus

[ ADMINISTRATION AA (15)

L[] ALTERNATIVE FUELS MM (23)

0 auTo BODY QQ (29)
CENTRAL PLANT (92)
CHILD DEV CENTER HH (26)
CONSTRUCTION TRADES MM (15
DIESEL RR (20}
FINE ARTS-SENIOR CTR FF (41)
FITNESS CENTER CC (18)
GREENHOUSE NNG (48)
HUMANITIES ESL BB (40)
INDUSTRIAL TECH I {1} (151)
INDUSTRIAL TECH IT (1) (90}

[ajojoiofoloioiofoioioiofioliojoioloioioiofioioioiolo)

OOooonoooooo
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FUSION - How do | navigate
Planning- Capital Outlay?

@ http://fusion du/code/admin/ htm

@ California State Communit... *

4 Hide Tree 0 Capital Outiay 5YP 0 Local Assislance

= Color Code PLANNING > District 5 Yeer Flan >
E Long Beach Community College District - 2017/2018

a

g 2017-18, 51 14-15 v

[ Pacific Coast Campus [ View Project ]
Priority Project Title Campus cat. Occupy Date Status 1 M 32 33 Funded MI: ot

O 1 :'g“‘"l"ifa‘?:"““ Facilty Replacement Liberal Arts Gampus B 20202021 FPP-Approved O 4

O 2 Construction Trades 1 Pacific Coast Campus c 202012021 FPP-Approved O 3

O 3 Construction Trades I Pacific Coast Campus c 20212022 1PP-Approved O 3

O 4 MusiciTheatre Complex (Bldg G & H) Liberal Arts Gampus c 20212022 1PP-Approved O

O 5 Language Arls Renavation Liberal Arts Campus c 201712018 ;“m“:r'g Funded or n} 0 n} 3

O 3 Science Building Lower Floor Remodel Liberal Arts Gampus c 20172018 'E“m‘:r'g Funded or [m] [m]

O 7 Performing Arts Renovation (Bldg J) Liberal Arts Gampus c 201712018 ;“;:r'g Funded or O o o o O

O 5 Electricity QQ & AR Pacific Coast Gampus B 201712018 ;“m“:r'g Funded or [m} O o o [m}

O 9 College Center Bldg E Renovation Liberal Arts Gampus o2 20182019 Locally Funded or [m] o o a [m]

O 10 Muli-Disciplinary Academic Buiding Pacific Coast Gampus c 201212013 FPP-Approved O u] 2z o2

7:14PM
DB s
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FUSION - How do | navigate
Planning - Local Assistance?

a

@ http://fusion du/code/admin/ htrn p-c It @
@ California State Communit... *
g 2016-17, SI 14-15| v
4 Hide Tree 0 Capital Quila P 0 Local A ance
= Color Code PLANNING > Locsl Assistance >
£ Long Beach Community College District - 2016/2017

[ Liberal Arts Campus
[ Pacific Coast Campus

Roof Utility Mechanical Exterior Other

Est Total St. Funds Est. Total St. Funds Est. Total St Funds Est. Total St. Funds Est. Total St. Funds
2016 $795,000 539,000 §798,000 5399,000 $798,000 $399,000 5796,000 $399,000 $795,000 539,000
2017 $795,000 539,000 $798,000 5399,000 $798,000 $399,000 5798,000 $399,000 $795,000 539,000
2018 $797,000 5398,500 5798,000 $399,000 $798,000 $399,000 5798,000 $399,000 $795,000 539,000
2019 5795,000 5399,000 798,000 5399,000 $798,000 399,000 5796,000 398,000 5795,000 539,000

2020 $798,000 5399,000 $798,000 $399,000 $793,000 $399,000 579,000 $399,000 798,000 399,000




FUSION - How do | navigate Project

- Capital Planning?

LI & hetp://fusion d

‘code/admin/

& California State Commu

Capital Ouflay Projects

=
[ Liberal Arts Campus
+ Multi-Disciplinary Facility Replacemer)
[ Pacific Coast Campus
+ Construction Trades 1
+ Multi-Disciplinary Academic Building

1.0 Capital Planning Projects 2.0 Local Assistance Projects

PLANNING » District Approved Projects >
Long Beach Community College District thru 2016

AEd hx @

& Home | Assessment | Spacelnventory | Planming  Project | @ Emanual

ange Planning Year: EITRIACSLRtIng

[ Review Project ]

Project Title Campus cat. OccupyDate  State Fund  Local Fund El 32 ) A:PEP'“

O 1 ?’E“:.'s'ﬂj“&"m‘“" Facilty Replacement e o) ads Campus B 202072021 520,602,000 520,802,000 4

O 2 Construstion Trades 1 Pacific Coast Campus c 202072021 56,356,000 55,447,000 3

O 10 Multi-Disciplinary Academic Buiding ~ Pacific oast Campus c 20122013 12,038,000 534,330,000 12
Total Funding: _ $39,483,000__ $60,679,000

15



FUSION - How do | navigate Project
- Capital Planning, Claims Review?

CMEI © hetp://fusion.deltacollege.edu/c o-ci RN

& California State Commu

& Home | Assessment | Spacelnventory | Planming  Project | @ Emanual

Change Planning Vear: Pl U QU BERE]
Capital Outlay Projects 1.0 Capital Planning Projects 2.0 Local Assislance Projects
Project > Capital Outisy Project>

Bl Long Beach Multi-Disciplinary Academic Building
[ Liberal Arts Campus Project Detail
+ Multi-Disciplinary Facility Multi_Discinli N

[ Pacific Coast Campus
+ Construction Trades 1

Project Details:
Campus: Pacific Coast Campus
Project Priority: 10
Project Title: Multi-Disciplinary Academic Building
Occupy Date: 201212013

Project Description: The complex that houses buildings AA, BB, DD and EE was previously a high school. The existing floor plan is grossly inadequate to support current and future academic programs. Numerous oversized classrooms make space ufiization extremely
inefficient. This campus requires o \nstrucbunn\ facliy capable of housing muple acadenvic isciplines, 2 mulluse iaboratory, tslecommunialions,distance eaming and medialed compuler nshucton 2% proposed. The existing academic programs wil
]

be included in the reconstructed space. Additional ESL classes, a mulfipurpese science laboratory, the Music Radic and Television Program, a communications center, instructional support space and faculty/staff offices are included. The proposed
renovation will provide a cantatized Aadamic Leaming Center to atiain transfer, degree and certi goals and the needed o meet evening and weekend program needs.
e e e e e TS T N T
$606,000  $334,000 5606,000 606,000 5870.301-6049 (14) 2007 6/30/2008  6/30/2010
w $661,000  $2,049,000 5861,000 $861,000 870:301-6049 (14) 2007 6/30/2008  6/30/2010
c 510,380,000 531216000  $10390,000 510,390,000 6870-301-6049 (6} 2009 ToBid 6302010
Bid Award 61302012 6/30/2014
3 §181,000  $184,000 5181,000 184,000 5870.301-6049 (6) 2009 63072015 6/30/2017
5870.490/12-Reappropriation
e o | Acion TRequestiate] ApproveDate |
1 Encumber and Release Preliminary Plans 802812007 8202007
2 Approve Prefiminary Plans /132008 SHaR005

Encumber and Release Working Drawings

3 Approve Working Drawrings 111912009 1211412009

Apprave Praceed fo Bid

4 Approve Construction Gontract Award
Augmentation 71612010 74712010
Encumber and Release Construction

5  Reversion 811312010 /2012010

6  Encumber and Release Equipment 11152012 121212012




FUSION - How do | navigate Project
- Capital Planning, Claims?

U © hetofusion deltacollege.edu

@ California State Communi

pL-c

#® kO

& Home | Assessment | Spacelnventory | Planming | Proje ? Emanual

Change Planning Vear: Pl U QU BERE]

Ann.

Capital Outlay Projects 1.0 Capital Planning Projects 2.0 Local Assislance Projects

Project > Capital Outisy Project>

B Long Beach Multi-Disciplinary Academic Building
B Liberal Arts Campus Project Detail Actions
+ Multi-Disciplinary Facility Replacemer) Claim List
B} Pacific Coast Campus Fund Encumb. Grant Claim. Rollover Grant Retention  Claim Total Total Disbursement  Grant  Unexpended
R oneudonil adesiL Amount No. 1D Date Type No. Amt Amt Amt Amt Interest Remai Balance  Balance
+ = = —= = == = — _— = ——
P 2007 3018048 (14) 4025117 (14} 3509.000 8 1252008 Reimb 1 55.43020 58.430.20 $507,510.71 Approves
12 31212008 Reimb 2 se.73490 5073490 $587.775.72 Appraved
18 aer2008 Reimb 3 541144068 s5411.84086 5176,326.08 Approves
51 6202008 Reimb 4 $70.200.05 570.208.05 397.119.11 Appraved
77 8iz2/2008 Reimb 5 $12.26032 s$1228032 584858.79 Approved
04 1011472008 Reimb & 32702041 527.62041 357.220.38 Approved
115 12412008 Reimb 7 $40.355.00 $40.355.00 S10874.38 Appraved
214 82372008 Reimb B 31087380 31087388 50.45 Approved
w007 3018040 (14) 4025117 (14) 3361000 05 1011472008 Reimb 1 $440.052.07 3446.068.07 $414.921.03 Agproved
18 12472008 Reimb 2 537180103 5371.801.08 542.050.00 Approved
517 &202010 Reimb 3 343.050.00 $43.050.00 50.00 Approved
€ 2000 2016048 (5) 4025117 (8) 510,380,000 1 s28 aR00 Grant 1 $8815.000 $881,600 $7,824,400.00 53,334,082.18 585.750.85 50.00 $881,800.00 52 455.800.00 Approved Gpen
2 111z arezott Grant z 541800.318 30 50 5000 34.507.220,42 515.828.50 30.00 30.00 32.456.600.00 Approved Gpen
3 1308 a27Z012 Grant 3 53088 52455600 $245.580 $2.210.040.00 52,387.108.88 50.00 S0.00 §245,580.00 $245.500.00 Approved Open
1412 71812012 Grant 4 $173.680.48 57157951 Approved Gpen
E 2000 3018048 (5) 4025117 (@) $181.000 1835 71212013 Reimb 1 $181.000.00 5121.000.00 $0.00 Approved




FUSION - How do | navigate Project
- Cap. Plan., Quarterly Reports?

CMEI © hetp://fusion.deltacollege.edu/c o-ci RN

& California State Commu

& Home | Assessment | SpaceInventory | Planning

Capital Outlay Projects 1.0 Capital Planning Projects 2.0 Local Assislance Projects

Projact > Capital Outisy Projects
Multi-Disciplinary Academic Building

B Long Beach
B Liberal Arts Campus Project Detail Actions

+ Multi-Disciplinary Facility Replacemer) Claims P o T @ Help he!
[ Pacific Coast Campus
+ Construction Trades 1 | Quarterly Report
Report Fiscal Year ~ { Change Request Date Created Date Approved Status

July 01,2010 2010- 2011 Form 14D 10162010 101912010 Approved
October 01, 2010 2010- 2011 Re-Appropriation 1072011 20212011 Approved
January 01, 2011 2010- 2011 12112011 512412011 Approved
apil 01, 2011 2010 - 2011 Augmentations/Reversions 70612011 Submitted
July 01,2011 2011-2012 x 10132011 212412012 Approved
October 01, 2011 2011-2012 x 11812012 212412012 Approved
January 01, 2012 2011-2012 x 41412012 4972012 Approved
July 01,2012 2012-2013 x 9112015 Active
April 01,2013 20122013 x 81112012 100612014 Approved
July 01,2013 20132014 x 81172015 Submitied
October 01, 2013 20132014 x 20612014 Submitted
January 01,2014 20132014 x 41172014 100612014 Approved
April 01,2014 20132014 x 81172015 211712016 Approved
July 01,2014 2014-2015 x 9112015 21712016 Approved
October 01, 2014 2014-2015 x 20612014 21712016 Approved
January 01,2015 2014-2015 x 2112015 211712016 Approved
April 01,2015 2014-2015 x 8102015 211712016 Approved
July 01,2015 2015- 2016 ® 2182015 21712016 Approved
October 01, 2015 20152016 x 121712015 211712016 Approved 1

January 01,2016 2015 - 2016 x 21002018 21712016 Approved




FUSION - How do | navigate Project
- Cap. Plan., Quarterly Reports?

e & hitp://fusion deltacollege.edu/cod

@ California State Communit... * Quarterly Report Form - Intemnet Explorer

dmin/default.htm

@ httpi//f deltacollege.edu/c. ject/qtrReportFrame.asp?plD=11888iqID= 16048tyr=20158iqtr=3 ssment | Spacelnventory | Planning | Project | Emanual

Change Planning Vear: Pl U QU BERE]

Multi-Disciplinary Academic Building (Pacific Coast Campus/Long Beach)

Capital Ouflay Projects

Quarterly Report Attachments
B Long Beach Quarterly Report @ Help Me!
[ Liberal Arts Campus Save || Reset || Del
+ Multi-Disciplinary Fadility Orgarization Title: Board of Governers, Califomia Gommunity Golleges : FY 2015- 16
istri " istri Help Me!
B pacific Const Campus Distriet: Long Beach Community College District or01090 ) 01010331 @rep
"+ Construction Trades 1 College/Center: Pacific Coast Campus
Project Title (per FUSION): Multi-Disciplinary Academic Building 100112131 [104/01-06730
Tile: 25
Organization: 6870, CFIS #: 40.25.117
State Fiscal Data Acquisition Preliminary Plans Working Drawings Construction i
Chapter # ftem # 171, 301-6048 (14)] 171, 301-6048 (14)] 1, 301-6048 (§)] 1, 301-6043 (6)
Reappropriation (Chapler?, lem) I I I 290/12]
Reappropriation (Chapter#, Item)
iation Amount - State 606,000/ 861,000, $15,612,000 181,000,
- State | | -85,222,000|

(0 Date or Chapter#, items#) €O 10111
[Total Financing - State 606,000 $861,000 510,390,000 181,000/

Procecd to Bid Date (per DF14D) | [ J

Release Date (per DF14D) /2912007 6/17/2008] 1T2010| 12112r2012|
Release Amount 861,000 510,390,000 181,000/
Grant Financing Released $10,318,420
Expenditures Reporled/Paid - State $861,000, $10,318,420 181,000,
iation Balance - State 0 71,550 30
Local Fiscal Data Acquisition Working Drawings Construction Ec

Initial Financing - Local
Current Financing - Local

51,253,000] 521,473,000
52,048,546/ 531,216,327

(Locally Funded) 531,215‘32%

Balance - Local 50
Project schedule/Status

Number of Change Orders T [ 28] | 1
Change Order Total | $1,880,860, <|
(Original Completion Date 1zmzﬂ| 8172008 6112012 6172012
Actual Completion Date 6/13/2003] 12/15/2008] 315/2013 815/2013
Beneficial Occupancy Date I AT2014
Close Fiscal Accounts Date 152016
|Pet Complete Financial (prior quarter) 102.60% 144.50%) 160.82% 50.00%)
|Percent Complete (current quarter) 100.00% 100.00%) 99.83% 100.00%

Gomments - Explain delays - Change orders delal - Issues pending - Contract Phase processed
This will be the final quarterly report because the project is now complete. Some of the budget numbers were changed because a full internal audit was completed before the project was closed.

T Cerfity thal the information reported is correct and the % complete is based on fhe progress of the project phase

Submitted by: Eric Mittlestead  2146/2016 Approve Date: 2/17/2016 Print
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